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Product Information

The SHC68-C68-S is a cable designed for use with the NI 7330, NI 7340, and NI 7350 motion controllers and
P7000 series stepper drives. This cable allows for the connection between the motion controller and the stepper
drive, enabling precise control of stepper motors. The P7000 series stepper drives are high-performance drives
designed for use with NI motion controllers. They provide accurate and reliable control of stepper motors, making
them suitable for a wide range of applications.

This manual helps you quickly install and configure the P7000 series stepper drives and stepper motors for use
with NI 7330, NI 7340, and NI 7350 motion controllers. It assumes you have already installed your National
Instruments motion controller and driver software. The driver CD installs the NI Measurement & Automation
Explorer (MAX) configuration files and documents referenced in this manual. You can find all the software, files,
and documents at ni.com/motion/stepper. Additionally, this manual assumes you are using either the NI Universal
Motion Interface (UMI)-7764 or NI UMI-7774/7772 and have the appropriate 68-pin cable for connecting to your NI
motion controller. Refer to the NI Stepper Motion System Selection Guide at ni.com/motion/stepper for assistance.
For specifications or installation questions about your NI motion controller or NI UMI, refer to the appropriate user
manual.

What You Need to Get Started

You need the following items to get started.

Hardware

NI 7330/7340/7350 motion controller

NI UMI-7764 or NI UMI-7774/7772

Power supply for the NI UMI:

+5 V if using the UMI-7764

+24 V if using the UMI-7774/7772

68-pin cable to connect your NI UMI and motion controller

P70360 or P70530 stepper drive

P7000 direct connect cable appropriate for the NI UMI you are using



DC power supply if using the P70530 stepper drive

NI or third-party stepper motor

NI or third-party encoder (optional)

RS-232 serial communication cable for P7000 drives (optional)

Software

NI-Motion 7.6 or later driver software

One of the following software packages and documentation:

LabVIEW 7.1.1 or later

LabWindows™/CVI™ 7.0 or later

Microsoft Visual C++ 6.0 or later

Microsoft Visual Basic 6.0 or later

NI Motion Assistant 2.2 or later (optional)

P7000 Tools configuration software (optional)

Note The RS-232 serial configuration cable and P7000 Tools configuration software are required only if you are
using a third-party motor. If you are using an NI stepper motor, you can perform configuration using only the DIP
switches on the drive.

Figures 1 and 2 shows the required hardware connections when using the P7000 Series stepper drives with the
UMI-7764 and UMI-7772/74 respectively.



Related Documentation
The following documents contain additional information that you may find helpful. All referenced documents ship
with the product and are available at ni.com/manuals.

NI 7330 User Manual, NI 7340 User Manual, or NI 7350 User Manual—Describes the electrical and mechanical

aspects of the NI 73xx motion controller, and contains information about installing and operating the device.

Getting Started with NI-Motion for NI 73xx Motion Controllers—Provides instructions for installing and getting

started with the NI-Motion driver software and NI PXI/PCI-73xx motion controllers.

P70360 (AC) High Performance Micro-stepping Drive Reference Guide—Provides additional information about

the electrical and mechanical aspects of the P70360 AC stepper drive, including important safety information.

P70530 (DC) High Performance Micro-stepping Drive Reference Guide—Provides additional information about

the electrical and mechanical aspects of the P70530 DC stepper drive, including important safety information.

NI-Motion Help—Contains information about selecting a motor, designing a basic move, designing a multi-axis

move, incorporating image and data acquisition into motion applications, and working with common motion

concepts, such as contouring and breakpoints. This document is task-based and takes you through each

phase of designing and executing a motion application.

http://ni.com/manuals


NI-Motion Function Help—Contains function reference information for C and Visual Basic and provides details

about each function, including a description of the function, a list of the function parameters, illustrations, and

error codes.

NI-Motion VI Help—Contains LabVIEW VI reference information and provides details about each VI, including

VI descriptions, lists of VI parameters, usage, illustrations, and error codes.

Measurement & Automation Explorer Help for Motion—Provides information about using MAX to configure the

NI 73xx motion controller as well as advanced conceptual information about topics such as Bode analysis and

control loop parameters.

Configuration and Installation

You can configure the P7000 series stepper drives using the external DIP switches or with software through the
RS-232 port. If you have an NI stepper motor, you can configure the drive and motor using only the DIP switches.
If you have a third-party motor, you must use the P7000 Tools configuration software. Complete the following
steps to configure your stepper drive and motor:

Step 1: Connecting the Stepper Motor to the Drive
Connect the stepper motor as shown in Figure 3. The NI stepper motors are highly recommended, as they are
optimized to work with the P7000 series stepper drives.
Caution Do not hot-plug the motor connector. Also, avoid “whiskers” from stranded phase leads protruding from
the motor plug.

The NI stepper motor wire color code is shown in Table 1.
Table 1. NI Stepper Motor Wire Colors

Phase Color

A– Orange

A+ Black

B– Yellow

B+ Red

PE Green/Yellow Stripe



Note To reverse the motor rotation direction, do one of the following:

Switch A– with A+

Switch B– with B+

Switch A–, A+ with B–, B+

National Instruments offers several standard stepper motors that provide optimum performance when matched
with the P7000 series stepper drive. The motors have a four flying lead configuration. If your motor has six or eight
leads, consult your distributor or the factory for assistance.

Step 2: Configuring the DIP Switches
Configure the DIP switches as follows for proper operation of your P7000 series stepper drive. Figure 4 shows
switches S2–1 through S2–12 in the OFF position for the P70360 drive.

Figure 5 shows switches S2–1 through S2–12 in the OFF position for the P70530 drive.

Using Table 4 or 5, set switches S1 and S2-1 to configure the drive for your motor, or use the serial configuration
using P7000 Tools if you are using a third-party motor.
For the remaining DIP switches, refer to Tables 2 and 3.
Note For DIP switch settings to take effect, you must power cycle the P7000 series stepper drive whenever you
make changes.
Table 2. DIP Switch Positions



Table 3. Drive Settings

Drive Option Setting

Motor selection Motor dependent (refer to Tables 4 and 5 for switch positions)

Step resolution 5,000 (refer to Table 6 for switch positions)

Load inertia 0–1 (refer to Table 7 for switch positions)

Dynamic smoothing Minimal (refer to Table 8 for switch positions)

Current reduction Enabled (refer to Table 9 for switch positions)

Multistepping Disabled (refer to Table 10 for switch positions)

Encoderless stall detection Disabled (refer to Table 11 for switch positions)

Motor Selection
Table 4 lists the switch settings for AC P70360-compatible motors. Table 5 lists the switch settings for DC P70530-
compatible motors.

Table 4. P70360-Compatible Motor DIP Switch Settings



Table 5. P70530-Compatible Motor DIP Switch Settings



Step Resolution
Table 6 lists the step resolution switch settings.

Table 6. Step Resolution DIP Switch Settings



Load Inertia
The P7000 series stepper drives eliminate the resonance typical of step motors with high-speed, digital
processing of motor electrical activity. To use this feature, you must set three switches based on the load-to-rotor
inertia ratio. These switches select the gain parameter the drive uses to stabilize the motor. You can calculate the
load inertia by hand or by using the Motioneering sizing software. If you do not know your inertia ratio, set the DIP
switches to OFF for a load-to-rotor inertia ratio of 0–1. Table 7 lists the load inertia switch settings.
Table 7. Load Inertia DIP Switch Settings



Dynamic Smoothing
Dynamic smoothing is a temporal filter (second-order, low-pass) applied to the command sequence to reduce
jerk. It helps reduce overshoot and lessens the excitation of mechanical resonance in the system. It filters from
slightly below the resonant frequency up to well above resonance to remove spectral content that would be
misrepresented in the motor output and may also excite other parts of the machine. Dynamic smoothing is a very
powerful feature for achieving maximum torque from the motor. However, it is difficult to optimize and is not
necessary for the vast majority of applications. Therefore, National Instruments recommends setting both DIP
switches to OFF for minimal smoothing Table 8 lists the dynamic smoothing switch settings.
Table 8. Dynamic Smoothing DIP Switch Settings

Current Reduction
Current reduction reduces drive and motor heating by invoking standby current reduction. When enabled, current
reduction cuts motor current to 75 percent of its commanded value 100 ms after receipt of the last step pulse. You
can adjust the reduction proportion and delay to other values using the P7000 Tools configuration software. When
current reduction is enabled, the motor holding torque is reduced. Do not enable it for applications that require full
holding torque when the motor is stationary.
Table 9 lists the current reduction DIP switch settings.
Note Current reduction is enabled when switch S2–10 is OFF.
Table 9. Current Reduction DIP Switch Settings



Multistepping
Multistepping is similar to dynamic smoothing, except it is a much more aggressive use of the filter. Typically, it
results in a filter that begins to roll off two octaves below the resonant frequency. This is intended for use with
coarse resolution (full/half-step input pulses) to smooth large steps into a continuous train of microsteps, and may
provide smoother motion depending on your motion application. Disable multistepping if you are not using full or
half step resolution.
Table 10 lists the multistepping switch settings.
Table 10. Multistepping DIP Switch Settings

Encoderless Stall Detection
The P7000 series stepper drive is uniquely designed to sense the motor shaft position at all times. The drive
monitors the commanded position and compares it to the actual position. As with any two-phase step motor, when
the shaft position and commanded position are greater than two full steps apart, a stall is detected, and the drive
faults.
Table 11 lists the encoderless stall detection switch settings.
Table 11. Encoderless Stall Detection DIP Switch Settings

Encoderless stall detection uses an internal motor model for stall detection. Motors listed in Tables 4 and 5 work
well with encoderless stall detection. Third-party motors may not work as well, as the algorithm is subject to
constraints. National Instruments makes no guarantees of reliability of this feature when using third-party motors.

Step 3: Connecting Power to the P7000 Drive
Connect either AC or DC input power to your P7000 series stepper drive. If you are using the P70360 drive,



connect AC power as shown in Figure 6. Refer to Table 12 for DC power connector pin descriptions. If you are
using the P70530 drive, connect DC power as shown in Figure 7. Refer to Table 13 for DC power connector pin
descriptions.

Connecting AC Power to the P70360
Caution Do not use J7 as an on/off switch. Hot plugging damages the connector.

Table 12. J7 AC Power for 320 VDC Bus

Pin Description

J7–1 120/230 VAC line

J7–2 230 VAC neutral

J7–3 120 VAC neutral

J7–4 PE (Protective Earth)

Refer to the P70360 (AC) High Performance Micro-stepping Drive Reference Guide, available from
ni.com/manuals or from the Product Support Package CD in your kit, for 160 VDC bus connection. This
configuration is required for third-party motors with 7 to 30 mH inductance.

Connecting DC Power

Table 13. J7 DC Power

http://ni.com/manuals


Pin Description

J7–1 (+Bus) Plus power supply terminal

20 to 75 V 5 A max Isolated, unregulated (
or regulated) power supplyJ7–2 (Gnd)

Negative power supply terminal

Negative power supply terminal/Bus Gnd is n
ormally earthed

Maximum allowable voltage between Bus Gn
d (J7–2) and Chassis (J7–3) is 100 V peak

J7–3 (PE) Connect to PE (Protective Earth) J7–3 connects to J6–5 inside drive (shield)

Note National Instruments recommends using insulated wire ferrules to prevent shorting and add strain relief.

Power on your DC or AC power supply. Once powered, the P7000 drive enters a configuration mode that causes
the LED to flash and the motor to audibly squeal. This is expected operation, as the drive is measuring the motor
windings to optimize its settings. Once complete, the status LED should illuminate green. If it is not, refer to the
Troubleshooting the P7000 Series Stepper Drive section.
Note The following step is required only if you are using the P7000 Tools configuration software and configuring
the drive with the RS-232 port. If you are using an NI stepper motor, you can configure the drive with the DIP
switches only and proceed to Step 7: Configuring the NI UMI to configure the NI UMI.

Step 4: Configuring the P7000 Drive with the Serial Port (Optional)

1. Connect the RS-232 serial communication cable between the drive and computer COM1 port. You must set the

COM1 port to the following settings:

Baud Rate: 19,200

Data Bits: 8

Parity: Even

Stop Bits: 1

Flow Control: None

2. Configure a COM port to be used with the serial cable. To change your COM port, open the Device Manager,

click Ports (COM & LPT), and double-click the desired COM port as shown in Figure 8



3. Select the Port Settings tab and change the settings as shown in Figure 9. Click OK to apply the new settings.

Close the Device Manager after this step.



Step 5: Installing the P7000 Tools (Optional)

1. Install the P7000 Tools configuration software. You can find the software at ni.com/motion/ stepper.

Note If you have a previous version of P7000 Tools on your system, the installation wizard automatically

uninstalls it. After the previous version is uninstalled, you must run the installer again to install the new version.

2. Launch the P7000 Tools configuration software. The setup wizard appears as shown in Figure 10.

3. Click Next, and the P7000 software searches for connected drives on the COM1 port. Once detected, the

product selection dialog appears as shown in Figure 11. You may enter a new name for the drive or leave the

default.



4. Click Next.

5. In the motor selection dialog, shown in Figure 12, select the NI stepper motor you have connected to the drive.

If you are using a third-party motor, select None from the list, click the Motor File Editor button, and enter the

motor information. The T23NRLC motor is selected in this example.



6. Click Next.

7. Click Next in the mechanical information, command values, and I/O functions dialog boxes. No changes are

required for these settings.

8. Click Finish. Your drive setup is complete. The P7000 Tools configuration software downloads the new

configuration data to your drive and performs an initialization process with the motor. You may see a dialog box

such as the one in shown Figure 13 when the configuration data is about to download. Click Yes to continue

the download process.

9. When the configuration data is downloaded, the drive performs the initialization process with the motor as

shown in Figure 14. Click OK.



Caution The motor shaft rotates when performing the following test.

Step 6: Testing the Motor With the P7000 Tools (Optional)
Test the motor and P7000 series stepper drive configuration by jogging the motor in the negative and positive
directions using the following arrows on the Motion Toolbar.

Note The RS-232 serial communication cable between the computer and P7000 series stepper drive is no longer
needed, but you can leave it connected.

Step 7: Configuring the NI UMI
Follow these steps to connect and configure your NI UMI. (Refer to Figure 1 for more information about
connecting the NI UMI to your stepper drive.)

1. Connect your 68-pin shielded cable between the Motion I/O connector on your NI motion controller and the

Motion I/O connector on your NI UMI.

2. Connect the P7000 direct connect cable between the NI UMI and the P7000 series stepper drive. If you are

using the NI UMI-7774/7772, connect the cable between the Control connector on the NI UMI and the

Command I/O connector on the drive. If you are using the NI UMI-7764, connect the leads from the cable to the

correct screw terminal. The leads are labeled with the same signal names as the NI UMI-7764 and can be

connected to any axis terminal block. You can connect the ground lead to any ground pin on the NI UMI-7764.

Refer to Table 14 for the wire colors.

Table 14. Wire Color Code for NI UMI-7764 to P7000 Direct Connect Cable



Wire Color Signal Name

Blue STEP (CW)

Red DIR (CCW)

Purple INHIN

Orange INHOUT

Black GND

Note: Overlined text indicates that a signal is active-low.

3. Configure the NI UMI slide switches. You must set the NI UMI switches to match the polarity configuration for

the P7000 series stepper drive, as shown in Tables 15 and 16.

4. Connect power to the NI UMI:

If you are using the NI UMI-7764, connect a +5 V external power supply to the two-position terminal block

labeled required inputs. Connect the positive lead of the +5 V power supply to the +5 V terminal, and the

negative lead to the digital ground (GND) terminal.

If you are using the NI UMI-7774/7772, connect the positive lead of the +24 V external power supply to

the V terminal and the negative lead to the C terminal, then connect the V terminal to the Viso terminal

and the C terminal to the Ciso terminal. Figure shows the power terminal block.

5. Note For more information about connecting external power, encoders, and other motion I/O signals, refer to

the Universal Motion Interface (UMI) Accessory User Guide and Specifications or National Instruments

Universal Motion Interface (UMI)-7774/7772 User Manual and Specifications.

Table 15. NI UMI-7774/7772 Switch Settings

Fault Enable

Active low Active high

Table 16. NI UMI-7764 Switch Settings

Inhibit Input Inhibit Output

Active high Active low



Step 8: Configuring Your NI Motion Controller Using Measurement & Automation Explorer (MAX)
To assist with configuring your NI motion controller, NI provides ready-made configuration files to configure your
motion controller with the P7000 series stepper drives. To import these files, launch MAX and select File»Import.
The Configuration Import Wizard appears as shown in Figure 16. The MAX configuration files are installed at <NI-
Motion>\Configuration, where <NI-Motion> is the location where you installed NI-Motion. In the Import from file
dialog box, browse to this directory and select the appropriate file for your motion controller. Table 17 lists the MAX
filename to import for each NI motion controller. After selecting the file, click Next.

Table 17. MAX Configuration Filenames for NI Motion Controllers

NI Motion Controller Configuration File

NI PCI/PXI-7330 <NI-Motion>\Configuration\ 7330 Settings for P7000 Drives.nce

NI PCI/PXI-7340 <NI-Motion>\Configuration\ 7340 Settings for P7000 Drives.nce

NI PCI/PXI-7350 <NI-Motion>\Configuration\ 7350 Settings for P7000 Drives.nce

Verify that the settings being imported are checked. You also can select the device that uses the imported settings
by clicking the Import Only link, as shown in Figure 17. After selecting the motion controller for the settings, click
Import.



You also can change the settings a device is using by clicking Change Settings and selecting the desired settings,
as shown in Figure 18.
Note The P7000 MAX configuration files are the same as the default settings, with the following changes:

Type is changed to Stepper in the Axis Configuration tab under Axis Configuration in the MAX Configuration

tree.

Stepper Loop Mode is changed to Open-Loop and Stepper Steps per Revolution is changed to 5000 in the

Stepper Settings tab under Axis Configuration in the MAX Configuration tree.

The Forward, Reverse, and Home Limit switches are changed to Disabled in the Motion I/O tab under Motion

I/O Settings in the MAX Configuration tree.



Click Initialize in MAX to send the settings to the NI motion controller, as shown in Figure 19.

Step 9: Testing the Motor Using MAX
You will now move the motor using the NI motion controller and MAX. Select the 1-D Interactive panel in the
Configuration tree and change the settings to match those shown in Figure 20. Change the axis if you are not
using Axis 1.



Note Limits are disabled with these configuration files. National Instruments recommends enabling limits in your
final application.
Click Start. Your stepper motor should move at the desired velocity.

Configuring Moves with NI Motion Assistant (Optional)

NI Motion Assistant is a motion control prototyping utility for quickly developing your motion control application.
You can use interactive menus to set up and configure move profiles. Complete the following steps to configure a
simple one-axis straight line move using NI Motion Assistant.

1. Launch NI Motion Assistant by selecting Start»All Programs»National Instruments» NI Motion Assistant.

2. Click Add Step. Select Straight Line Move from the Add Step dialog box.

3. Click the 1D button to set up a single axis move. Choose the axis you want to control.

4. Click the Position tab. Enter the number of steps or revolutions you want the motor to move.

5. Click Run on the toolbar to execute the move.

Exporting to LabVIEW
After prototyping your moves using NI Motion Assistant, you can export the move profile to LabVIEW for further
motion control system development. To export to LabVIEW, select Tools»Generate Code»LabVIEW Diagram.
Figure 21 shows an example block diagram generated from NI Motion Assistant. To execute the code, click the
Run arrow in the LabVIEW toolbar.



You have now successfully built a LabVIEW application to move a stepper motor using a P7000 series stepper
drive. You are now ready to develop advanced applications. For additional information, refer to
ni.com/motion/stepper.

Troubleshooting

Troubleshooting the P7000 Series Stepper Drive
Table 18 lists problems you may encounter with the P7000 series stepper drive and their possible causes.
Table 18. P7000 Series Stepper Drive Troubleshooting

Problem Possible Causes

The status LED on the drive is off, blinks, or is red.
The power source is not properly connected. Refer to t
he P70360 or P70530 Reference Guide for detailed L
ED troubleshooting.

The motor does not move using the jog toolbar in the 
P7000 Tools configuration software.

The DIP switches are not properly configured.

The DIP switches were changed but the drive was not 
power cycled.

Motor gets hot when idle. Current reduction is disabled.

Motor moves backwards. Refer to Step 1: Connecting the Stepper Motor to t
he Drive.

The P7000 Tools configuration software does not dete
ct the drive.

Verify that the drive is connected to the COM1 port on 
the computer.

Verify that the COM1 port settings are correct as descr
ibed in Step 4: Configuring the P7000 Drive with th
e Serial Port (Optional).

Power is not properly connected. Verify that the green 
LED is on.

http://ni.com/motion/stepper


Where to Go for Support

The National Instruments Web site is your complete resource for technical support. At ni.com/support you have
access to everything from troubleshooting and application development self-help resources to email and phone
assistance from NI Application Engineers. National Instruments corporate headquarters is located at 11500 North
Mopac Expressway, Austin, Texas, 78759-3504. National Instruments also has offices located around the world to
help address your support needs. For telephone support in the United States, create your service request at
ni.com/support and follow the calling instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office. Visit the Worldwide Offices section of ni.com/niglobal to access the
branch office Web sites, which provide up-to-date contact information, support phone numbers, email addresses,
and current events.

CVI, LabVIEW, National Instruments, NI, ni.com, the National Instruments corporate logo, and the Eagle logo are
trademarks of National Instruments Corporation. Refer to the Trademark Information at ni.com/trademarks for
other National Instruments trademarks. The mark LabWindows is used under a license from Microsoft
Corporation. Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
Other product and company names mentioned herein are trademarks or trade names of their respective
companies. For patents covering National Instruments products/technology, refer to the appropriate location:
Help»Patents in your software, the patents.txt file on your media, or the National Instruments Patent Notice at
ni.com/patents.
© 2007–2010 National Instruments Corporation. All rights reserved.

COMPREHENSIVE SERVICES
We offer competitive repair and calibration services, as well as easily accessible documentation and free
downloadable resources.

SELL YOUR SURPLUS
We buy new, used, decommissioned, and surplus parts from every NI series We work out the best solution to suit
your individual needs.

Sell For Cash

Get Credit

Receive a Trade-In Deal

OBSOLETE NI HARDWARE IN STOCK & READY TO SHIP
We stock New, New Surplus, Refurbished, and Reconditioned NI Hardware.
Bridging the gap between the manufacturer and your legacy test system.

1-800-915-6216
www.apexwaves.com
sales@apexwaves.com

Request a Quote CLICK HERE SHC68-C68-S

Documents / Resources

NATIONAL INSTRUMENTS NI 7330, 7340, 7350 Motion Controllers and P7000 Series Step
per Drives [pdf] User Guide
70530, 70360, 7330, 7340, 7350, NI 7330 7340 7350 Motion Controllers and P7000 Series Ste
pper Drives, NI 7330, NI 7340, NI 7350, NI 7330 Motion Controllers and P7000 Series Stepper 
Drives, NI 7340 Motion Controllers and P7000 Series Stepper Drives, NI 7350 Motion Controlle
rs and P7000 Series Stepper Drives, Motion Controllers and P7000 Series Stepper Drives, Mot
ion Controllers, P7000 Series Stepper Drives, Stepper Drives, Drives

http://ni.com/support
http://ni.com/support
http://ni.com/niglobal
http://ni.com/patents
http://www.apexwaves.com
mailto:sales@apexwaves.com
https://www.apexwaves.com/modular-systems/national-instruments/ni-cables/SHC68-C68-S?aw_referrer=pdf
https://manuals.plus/m/7386483dd4326fdd96c945c8489f0daa2db2c50ec20beb097ec4cd3af5578f1b
https://manuals.plus/m/7386483dd4326fdd96c945c8489f0daa2db2c50ec20beb097ec4cd3af5578f1b_optim.pdf


References

 Engineer Ambitiously - NI

 Engineer Ambitiously - NI

 Product Documentation - NI

 Shop - NI

 Shop - NI

 Contact Us - NI

 National Instruments Patents - NI

 NI Trademarks and Logo Guidelines - NI

 National Instruments SHC68-C68-S Shielded Cable | Apex Waves

Manuals+,

http://ni.com
http://ni.com/
http://ni.com/manuals
http://ni.com/motion/
http://ni.com/motion/stepper
http://ni.com/niglobal
http://ni.com/patents
http://ni.com/trademarks
https://www.apexwaves.com/modular-systems/national-instruments/ni-cables/SHC68-C68-S?aw_referrer=pdf
https://manuals.plus/

	NATIONAL INSTRUMENTS NI 7330, 7340, 7350 Motion Controllers and P7000 Series Stepper Drives User Guide
	NATIONAL INSTRUMENTS NI 7330, 7340, 7350 Motion Controllers and P7000 Series Stepper Drives
	Product Information
	What You Need to Get Started
	Configuration and Installation
	Configuring Moves with NI Motion Assistant (Optional)
	Troubleshooting
	Where to Go for Support
	Documents / Resources
	References



